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Overview 

 

Pivot Tables are one of Microsoft Excel's most powerful features. Pivot Tables are interactive 

tables that allow you to manage and summarize substantial amounts of data, in a concise format 

for easy reporting and analysis. Therefore, this manual is an introduction to Excel Pivot Tables 

2016. These instructions illustrate how you can summarize and manipulate your worksheet data 

by using Pivot Tables, Filters, Slicers, and Pivot Charts. This manual will also help you 

summarize a vast amount of data contained in a spreadsheet, in a concise format for easy 

reporting and analysis. The instructions will include efficient ways to control, organize, and 

present your data by Managing Totals, Grouping Data, Conditional Formatting, and Creating 

Macros. This systematic manual shows the basics of creating a Pivot Table in Excel and helps you 

understand how powerful Pivot Tables can be. 
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I. Create a PivotTable 

Open the Excel2016_Pivot_Practice.xlsx file. The instructor will direct you to the file location.  

 

 

 

 

 

 

 

 

 

 

 

 

1. Click inside any cell on the spreadsheet that contains data you want to use.  

 

 

 

 

 

 

2. Select the Insert tab, and then click on the PivotTable button.  

 



 

File: Excel PivotTables 2019                               Page 5 of 53 11/01/19 

 

3. The Create PivotTable dialog box will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Choose the Select a table or range button (use Table1 as your source data).  

 

5. Choose the New Worksheet button (this will place your PivotTable on a new 

worksheet). 

 

6. Click on the OK button. 

 

7. A blank PivotTable along with the PivotTable Fields will appear on a new worksheet.  
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Note: In this PivotTable, you can decide which fields to add. Each field is simply a column header 

from your source data. In the PivotTable Fields section, click on the box for each field you choose 

to add.  

 

 

8. The scenario question for this exercise will be: What is the total amount sold by each 

salesperson?  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Click inside the boxes next to the Salesperson and Order Amount fields.  

 

 

10. The selected fields are added to one of the four areas below the PivotTable Fields. In 

this exercise, the Salesperson field is added to the Rows area, while the Order Amount 

has been added to the Values area.  

 

 

 

Note: You can also place your mouse pointer on a field, then hold down the right mouse button, 

and drag and drop the field to the desired area (FILTERS, COLUMNS, ROWS, VALUES). 
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The PivotTable will calculate and summarize the selected fields. In this exercise, the PivotTable 

shows the amount sold by each salesperson.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Total amount sold 

by each salesperson 
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You can sort the data on your PivotTable by using the Sort & Filter button, located on the 

Home ribbon.  

 

 Note: You can also apply any type of number formatting to your data. Some types of 

formatting may disappear when you modify your PivotTable. 

 

 

II. Update PivotTable Data 
 

If you change any data on your source worksheet (Bookstore Sales), the PivotTable will not update 

automatically. To update your PivotTable data, select any cell on your PivotTable, and then the 

PIVOTTABLE TOOLS ribbon will appear. 

 

 

 

 

 

 

 

1.  Click on the Analyze tab. 

2.  Click on the Refresh button. Your PivotTable will reflect any changes to your source 

worksheet. 
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III. Pivoting Data 

PivotTables allows you to quickly reorganize data, so that you can view your worksheet data in 

diverse ways. Pivoting data can help you experiment the data to discover trends and patterns. 

1. The earlier exercise scenario question was: What is total amount sold by each 

Salesperson?  

 

2. This exercise scenario question will be: What is the total amount sold in each Term? 

You can do this by changing the field in the Row section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. To select a different Field for the ROWS section, go to the PivotTable Fields section 

and deselect the Salesperson field. This will remove the Salesperson field from the 

ROWS section. 

 

4. Click on the box next to the Term field. The Term will appear in the ROWS section.  

 

 

 

 

 

 

 



 

File: Excel PivotTables 2019                               Page 10 of 53 11/01/19 

 

5. The PivotTable will adjust to show the new field choice. Your data now shows the total 

order amount for each term.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

Note: You can also add or remove Field names to the ROWS or VALUES sections by using the 

drag and drop feature. To add a Field to the ROWS or VALUES area, place your mouse pointer 

on the desired Field name found in the PivotTable Fields section, hold down the right mouse 

button, and then drag and drop in the ROWS or VALUES section. To remove a Field from the 

ROWS or VALUES section, place your mouse pointer on the desired Field found in the ROWS 

or VALUES section, hold down the right mouse button, and then drag and drop anywhere 

outside of the ROWS or VALUES section.  
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IV. Add Columns 

You can show multiple columns on your PivotTable. As noted above, you can drag and drop 

Fields into any of the PivotTable sections (Filters, Columns, Rows, and Values). In this exercise 

you will use the drag and drop feature. 

1. The earlier exercise you created a PivotTable showing the total order amount for each 

term. For this exercise, you will include columns with each Branch campus that reflects 

their order amount for each Term.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Place your mouse pointer on the Branch field, hold your left mouse button down, then 

drag Branch to the COLUMNS section, and release your mouse button. 

 

3. The PivotTable will include a column for each Branch campus.  

 

 

 

 

 

 

 

 

 

Note: There are automatic filter buttons on the Row and Column labels. This enables you to 

customize your data by selecting or omitting any label item. 
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V. Filters 

Sometimes you may want focus on just a certain choice of your data. Filters are used to narrow 

down the data on your PivotTable, allowing you to view only the information you need. 

1. In this exercise, you will filter certain salespeople to find how they affect the total sales. 

You will drag a field item from the PivotTable Fields to the Filters section.  

 

 

 

 

 

 

 

 

 

 

 

2. Place your mouse pointer on the Salesperson field, hold your left mouse button down, 

then drag Salesperson to the FILTERS section, and release your mouse button. 

 

 

3. The Salesperson filter will appear on the top row of your PivotTable.  
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4. Click on the filter drop-down arrow next to Salesperson. 

 

5. The tree list for Salesperson will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Click in the check box next to Select Multiple Items.  

 

7. Notice all the salespeople contained in your data are a part of the selection. 

 

8. Now you can deselect any sales person within your data. The sales total will not reflect 

any deselected person’s sales. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Deselect the box for any field item you do not want to include in the PivotTable. In this 

exercise, you will deselect the boxes for two different salespeople (Melissa Post and 

Chris Walters). 

 

10. Click on the OK button.  

 



 

File: Excel PivotTables 2019                               Page 14 of 53 11/01/19 

 

11. The PivotTable will adjust to reflect your changes. Notice the decrease in the Grand 

Total due to omitting the two salespeople. 

 

 

 

 

 

VI. Slicers 

Slicers make filtering data on PivotTables easier and faster. Slicers are Filters, but allows you to 

instantly pivot your data. If you often use Filters on your PivotTables, you may want to consider 

using Slicers instead of Filters. 

A. Add a Slicer 
 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select any cell on your PivotTable. 

 

 

 

 

 

 

 

2. The PIVOTTABLE TOOLS ribbon will appear. 
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3. Click on the Analyze tab, found on the PIVOTTABLE TOOL ribbon, and then click on 

the Insert Slicer button.  

 

4. The Insert Slicers dialog window will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Select your desired Field/s. In this exercise, click on the box next to Salesperson. 

 

6. Click on the OK button.  

 

 

 

 

 

 

7. The Slicer will appear on your PivotTable. Each selected Field item is highlighted.  
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8. Just like Filters, you can select or deselect items on the Slicer. The PivotTable will 

instantly reflect your choice. Try selecting different Field items to see how it will affect 

your data. To select multiple Field items from a Slicer, click on your first choice, then 

hold down the Ctrl key and select your other desired item/s.  

 

9. You can also click on the Filter icon on the top-right corner of the Slicer window to 

select all items at once. 

 

 

VII. Pivot Charts 
 

Pivot Charts are like Charts and displays data from your PivotTable. Like Charts, you can select 

a chart type, layout, and style that best represents your data. 

 

In this exercise, you will change the PivotTable data to show each Salesperson's total sales by 

Term.  

 

 

 

 

 

 

1. Deselect Salesperson, Branch, and Term fields by clicking on their check boxes. 
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2. Place your mouse pointer on the Salesperson field, hold down the left mouse button and 

then drag and drop Salesperson into the ROWS section. 

 

3. Place your mouse pointer on the Term field, hold down the left mouse button and then 

drag and drop Term into the COLUMNS section. 

 

 

A. Create a PivotChart 
 

A Pivot Chart will help you see your information more concise. 
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1. Select any cell in your PivotTable.  

 

 

 

2. Click on the Insert tab, and then click on the PivotChart button.  

 

3. The Insert Chart dialog box will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Select your desired chart type and layout. For this exercise, select the default 

Column chart type. 

 

5. Click on the OK button.  
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6. The PivotChart will appear next to your PivotTable.  

 

 

 

 

 

 

 

 

 

 

B. Use Slicer to Change Data 
 

The following instructions will illustrate how to change your data display by using the Slicer and 

Filters. The PivotChart and PivotTable will automatically adjust to show the data change. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click on the Salesperson, Walters, Chris found on the Slicer. Notice the PivotChart 

and PivotTable automatically reflects your choice. 
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2. Click on the Salesperson, Albertson, Kathy found on the Slicer. Notice the PivotChart 

and PivotTable automatically reflects your new choice. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Albertson is the selected on the Slicer, so now hold drop the Ctrl key while clicking on 

the salespeople, Davis, William and Post, Melissa. Notice your selections automatically 

reflect information for all three sales people.  
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4. Click on the Filter button, found on the Slicer. Notice all the salespeople are reselected 

and the PivotChart and PivotTable automatically reflect your action.  

 

 

 

C. Use Filters to Change Data 
 

 

 

 

 

 

 

 

 

    1. Click on the drop-drown arrow next to the Column Labels, found on the PivotTable.  

Notice you have the choice of selecting one or multiple columns that will reflect your  

data choice. 
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VIII. Connect to an External Data Source 
 

You can use data that is not stored in your active worksheet. This section illustrates how to 

connect to an external data source that is located on your computer’s system drive. (For future 

reference – workshop hands-on instruction starts in section 2.) 

1.  Launch an active Excel worksheet. 

 

 

 

 

 

2. Select the Insert ribbon tab, and then click on the PivotTable button. 

 

 

3. The Create PivotTable window will appear. 

 

 

 

 

 

 

 

 

 

4. Select the Use an external data source radio button, and then click on the Choose 

Connection button. 
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5. The Existing Connections window will appear. 

 

 

 

 

 

 

 

 

 

 

6. Click on the Browse for More button. 

7. The Select Data Source window will appear. 

 

 

 

 

 

 

 

 

 

8. Navigate to where your file is located, and then select it. 
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9. Click on the Open button. 

10. The Select Table window will appear. 

 

 

 

 

 

 

11. Your external data file will appear selected in the Name section. 

12. Click on the First row of the data contains column headers check box. (Your data  

      file should have the column headers in the first row.) 

13. Click on the OK button. 

14. The Create PivotTable window will appear. 

 

 

 

 

 

 

 

15. Select the Existing Worksheet radio button. (Notice that the Location of your 

      external file begins in the first cell.) 

16. Click on the OK button.  

17. The bare-bone PivotTable sheet will appear. 
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18. Now you can create a PivotTable by selecting the desired PivotTable fields. 

 

IX. Create a Recommended PivotTable 

Microsoft Excel provides multiple recommended PivotTables to choose from that correlate with 

your spreadsheet data. To illustrate the various recommended PivotTables, open the 

Excel2016_PivotTable Level 2_PracticeFile.xlsx file. (The instructor will direct you to the file 

location.)  

 

 

 

 

 

 

 

 

11. Click on any cell in the spreadsheet that has data.  
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12. Select the Insert ribbon tab, and then click on the Recommended PivotTable button.  

 

13. The Recommended PivotTable dialog box will appear. On the left-side of the dialog 

box, several recommended PivotTable will appear based on your spreadsheet data.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

14. Select the PivotTable that best represents your desired data structure. For this exercise 

choose the Sum of Sales by Department PivotTable preview.  

 

15. Click on the OK button.  

 

Note: There may be Recommended PivotTables that do not represent an appropriate data  

          structure. If so, click on the Blank PivotTable button to create your PivotTable from  

          scratch. 



 

File: Excel PivotTables 2019                               Page 27 of 53 11/01/19 

 

 

 

16. The Sum of Sales by Department PivotTable will appear. 
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X. Manage Subtotals and Grand Totals 

Microsoft Excel allows you to manipulate the default structure of your PivotTable’s Subtotals 

and Grand Totals. This section will illustrate how to manage you Subtotals and Grand Totals by 

using the previous Recommended PivotTable from section II with a slight pivot.  

 

 

 

 

 

 

 

 

 

 

 

1. Place your mouse pointer over the Campus field, and then hold down the left mouse 

button. 

 

2. Drag the Campus field to the ROWS section, and then drop (release the mouse button) 

above the Department field.   

 

3. Place your mouse pointer over the Term field, and then hold down the left mouse button. 

 

4. Drag the Term field to the COLUMNS section, and then drop (release the mouse 

button).   

 

5. Your new PivotTable will appear.  

6. Each Campus Bookstore and its associated Departments are on the PivotTable rows. 

The Terms are listed in the PivotTable columns. Notice that the Subtotals are listed 

above the Department entries. Individuals who read from top to bottom may desire to 

have the Subtotals at the bottom of the Department entries. The following steps will 

illustrate how to reverse your Subtotals from top to bottom. 
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7. To reverse the location of your Subtotals from top to bottom, go to the PIVOTTABLE 

TOOLS ribbon. 

 

8. Select any data cell in your PivotTable. 

 

 

 

 

 

 

 

 

 

 

 

 

9. Select the DESIGN ribbon tab, and then click on the Subtotals button. 

 

10. Select the Show all Subtotals at Bottom of Group from the menu options. 
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11. The Subtotals appear below your campus department list.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. You also have the option of removing your Subtotals and only have the Grand Totals 

appear. 

 

 

 

 

 

 

 

 

 

 

 

 

13. On the PIVOTTABLE TOOLS ribbon, select the DESIGN tab. 

 

14. Click on the Subtotals button. 

 

15. Select the Do Not Show Subtotals from the menu options. 
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16. Only the Grand Totals appear on your PivotTable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

XI. Group PivotTable Fields 

When a large amount of data is contain in the PivotTable’s rows, then it is difficult to read or 

understand specific data. The Group feature in PivotTable allows you to show and hide data to 

make sense of only the data you desire to view.  

 

A. Hide Detail 
 

Microsoft Excel allows you to hide data in your PivotTable, so that your desired data is visible. 

The PivotTable below list each campus bookstore and its associated department sales for each 

Term. This exercise will illustrate how to hide each bookstore department sales entry and only 

show the campus totals. 
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1. The Hide Detail button appears on the left side of each Campus name.  

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click on each of the Hide Detail buttons. The Campus Bookstores’  

    Department Sales are hidden and only the Subtotals and Grand Totals appear. 

 

 

 

 

 

 

 

 

 

 

 

3. When the Department data is hidden, the Show Detail button will appear next to the  

    Campus name.  

 

4. Click on the Show Detail button to view each department sales again. 
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B. Group Data 
 

The Group feature allows you to group data that you desire to be hidden in PivotTable. 

 

1.  In this exercise the Greensburg Campus Bookstore data will be used to illustrate how to  

     hide department entries. Only two department entries (General Books and Textbooks) will  

     be viewed. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select the entire 7 thru 10 rows. These data entries will be grouped then hidden. 

 

 

 

 

 

 

 

3. Select the DATA ribbon tab, and then click on the Group button. 

 

4. The Grouping Level indictor appears with a Hide Detail button on the left-side of rows 7 thru 10. 

 

 

 

 

 

 

 

 

 

 

 

17. Click on the Hide Detail button. 

 

18. The department entries that were grouped are hidden. Only the General Books and 

Textbooks Departments entries appear. The Bookstore’s Subtotals and Grand Total still 

reflect the totals from the hidden departments as well. 
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8. Click on the Show Detail button to view the hidden data rows. 

 

9. To remove Grouping Level indicator, select the entire 7 thru 10 rows again. 

 

 

 

 

 

 

 

 

 

 

10. Select the DATA ribbon tab, and then click on the Ungroup button. 
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XII. Data Field Number Format 
 

When you create a PivotTable, Microsoft Excel does not apply number formatting. This section 

will illustrate how to apply number formatting to the body of your PivotTable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Select any cell with a value in the body of your PivotTable. (Do not select text.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Place your mouse pointer on the selected cell and hold down the right mouse button. 

 

12. Select the Number Format option from the menu options.  
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13. The Format Cells dialog window will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

14. In the Category section, select Currency. 

 

15.  In the Sample section, select 2 Decimal places for this exercise. 

 

16. In the Symbol section, select the $ symbol (represents U.S. currency). 

 

17. Click on the OK button.  

 

18. The Currency and Decimal formats are applied to all of your values. 
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XIII. Conditional Formatting 
 

A. Highlight top or bottom values  
 

Conditional Formatting allows you to highlight the top, bottom, or average values in the body of 

your PivotTable.  

 

1. This exercise will illustrate how to highlight the top four values in the body of your 

PivotTable.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select any cell with a value in the body of your PivotTable other than a Subtotals or 

Grand Totals.  

 

3. On the Home ribbon, click on the Conditional Formatting button located in the Styles 

group. 

 

4. The Conditional Formatting menu options will appear. 
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5. Select the Top/Bottom Rules option, and then click on the Top 10 Items options. (You 

have the option of selecting the top, bottom, average, or percentage items.)  

 

6. The Top 10 Items window will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. In the Format cells that rank in the TOP box, click on the drop-down arrow until you 

get to the number 4. (You can also select a range from 1 to 10.) 

 

8. In the with box, select Light Red Fill. (You can select your desired color for the text and 

highlight.) 

 

9. The formatting is only applied to your cell selection. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Click on the Formatting option button that appears next to the highlighted cell. 
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11. The Apply formatting rule to menu options will appear.  

 

 

 

 

 

 

 

 

 

12. Select the All cells showing “Sum of Sales” values for “Department” and Term” 

option. 

 

 

Note: Selected cells will apply formatting only to your cell section. All cells showing “Sum  

          of Sales” values will include values with Totals in your cell selections. All cells  

          showing “Sum of Sales” values for “Department” and Term” will omit values with  

         Totals from your cell selections. 

 

 

 

13. Your selected Conditional Formatting highlights the scope of your top 4 sales. 

 

 

 

 

 

 

 

 

 

 

 

14. To apply Conditional Formatting highlight to the bottom or average values, follow the 

instructions in this section and select the appropriate option in step 5. 
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Note: To remove Conditional Formatting, hold down the Ctrl / Z keys. 

 
 

 

B. Apply Cell Rules 
 

 

Conditional Formatting applies specific rule conditions to your cell values. For example, identify 

sales that are less than or greater than to a determined value. 

 

1. This exercise will illustrate how to find values in your PivotTable greater than 1100. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click in any cell with a value in the body of your PivotTable other than Subtotals or  

    Grand Totals. 
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3. On the Home ribbon, click on the Conditional Formatting button, located in the Styles  

    group. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Select the Highlight Cells Rules on the menu options. 

 

5. Click on the Greater Than from the options panel. 

 

6. The Greater Than window will appear. 

 

 

 

 

 

 

 

 

 

 

 

7. In the Format cells that are GREATER THAN box, type 1100. 

 

8. Click on the drop-down arrow in the with box, and then select the Green Fill with Dark  

          Green Text option (select your desired option). 

 

19. Click on the OK button. 
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20. The Conditional Formatting will appear on the cell section in the body of your  

            PivotTable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

21. Click on the Formatting options button that appears next to the highlighted values cell. 

  

22. The Apply formatting rule to menu options will appear.  

 

 

 

 

 

 

 

 

 

 

 

23. Select the All cells showing “Sum of Sales” values for “Department” and Term” 

option. 

 

 

Note: Selected cells will apply formatting only to your cell section. All cells showing “Sum 

          of Sales” values will include values with Totals in your cell selections. All cells  

          showing “Sum of Sales” values for “Department” and Term” will omit values with  

          Totals from your cell selections. 
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24. Your selected Conditional Formatting highlights all department sales greater than 1100. 

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: To remove Conditional Formatting, hold down the Ctrl / Z keys. 

 

 

C. Data Bars  
 

Conditional Formatting also makes it easier for you to compare the ratio among the data on your 

PivotTable by adding data bars next to the values. 

 

1. This exercise will illustrate how to apply Data Bars to your PivotTable values. 
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2. Click in any cell containing a value in the body of the PivotTable other than Subtotals or 

Grand Totals. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.  On the Home ribbon, click on the Conditional Formatting button located in the Styles  

        group. 

 

4. Select the Data Bars on the menu options. 

 

5. Select on the Solid Fill from the options panel. 

 

 

Note: Do not use the Gradient Fill options, because data bars fade out and will not 

    be easy to interpret. 

 

 

6. The Formatting option button will appears next to the cell section in the body of your 

PivotTable. 
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7. Click on the Formatting options button. 

 

8. The Conditional Formatting Data Bars will appear next to each number according to its 

amount ratio. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The first column on a PivotTable is wider than the consecutive columns. When Data Bars  

          are applied, the bars in the first column are not be proportional with the other column Data  

          Bars and gives a false ratio comparison.  

 

 

 

 

 

9. The following steps will illustrate how to make your first column the same width as the 

other PivotTable columns. 
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10. Click on the Design ribbon tab, and then click on the Report Layout button. 

 

11. Select the Show in Outline Form option. 

 

12. The first column will readjust to the same width as the other PivotTable columns. Now 

the first column Data Bars have the appropriate ratio. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: To remove Conditional Formatting, hold down the Ctrl / Z keys. 

 

 

 

XIV. Create PivotTable Macros 
 

You can save the configuration of a PivotTable that you like for future use by creating a Macro. 

The Macro will record the steps it took to construct your desired PivotTable. Your recorded 

Macro will automatically run the steps to create your desired PivotTable.  

 

A. Recording a Macro 
 

1. In this exercise, you will pivot your data as shown below, and then create a Macro that 

contains the same PivotTable body configuration. 
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2. In the PivotTable Fields area, deselect the Department field. 

 

 

 

 

 

 

 

 

 

 

3. To create your PivotTable Marco, click on the VIEW ribbon tab. 

 

4. Click on the Macros button. 

 

5. Select the Record Macro option. 

 

6. The Record Macro window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. In the Macro name box, type your desired Macro name with no spaces 

(CampusBookstoreSales). 

 

8. Click on the OK button. 

 

9. At this point, you are ready to record your PivotTable by first clearing the current fields, 

and then reconstruct them.  

 

 

 



 

File: Excel PivotTables 2019                               Page 48 of 53 11/01/19 

 

10. Click inside any data cell in your PivotTable. 

 

 

 

 

 

 

 

 

 

11. Click on the PivotTable Analyze tab. 

 

12. In the Action group click on the Clear button, and then select the Clear All option. 

 

13. Now that the PivotTable is clear, you can reconstruct your PivotTable from scratch. 

 

 

 

 

 

 

 

 

 

 

14. Drag and drop the Campus field in the ROWS area. 

 

15. Drag and drop the Sales field in the VALUES area. 

 

16. Drag and drop the Campus field in the ROWS area. 

 

17. Now that you have reconstructed your PivotTable, stop recording your Macro. 

 

 

 

 

 

 

 

 

 

 

 

18. Select the VIEW ribbon tab. 

 

19. Click on the Macros button, and then select the Stop Recording option. 
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B. Running a Macro 
 

 

1. To run your Macro, clear your PivotTable as below. 

 

 

 

 

 

 

 

 

 

 

 

2. Deselect your PivotTable fields. 

 

 

 

 

 

 

 

 

 

 

3. Select the VIEW ribbon tab. 

 

4. Click on the Macros button. 

 

5. Select the View Macros option. 

 

6. The Macro window will appear. 
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7. Select your desired Macro name (CampusBookstoreSales). 

 

8. Click on the Run button. 

 

9. The PivotTable configuration associated with your Macro selection will appear. 

 

 

 

 

C. Quick Access Macros 
 

When running a Macro multiple times, you can create a Quick Access Macro to decrease the 

amount of steps to run your Macro by attaching a Macro button on the Quick Access Toolbar.  

 

 

1. Once a Macro have been created, you can add a Macro button to the Quick Access 

Toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click on the Quick Access Toolbar drop-down arrow. 
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3. Select the More Commands option. 

 

4. The Excel Options window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. On the Choose command from options panel, click on the drop-down arrow. 

 

6. Select the Macros option. 

 

7. All Macros that you have created will appear in the Separator window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Select your desired Macro (CampusBookstoreSales). 

9. Click on the Add button. 
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10. Your Macro selection will appear in the Customize Quick Access Toolbar options panel 

on the left-side.  

 

11. Click on the OK button. 

 

12. The Macro Icon will appear on the Quick Access Toolbar.  

 

13. Click on the Macro Icon to run your Macro. 

 

 

Note: If you create more than one Quick Access Macro, you have the option of selecting   

          multiple icons styles that will represent your different Macros.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Once your Macro name is added to the Customize Quick Access Toolbar option panel, 

select your Macro name. 

2. Click on the Modify button.  

3. The Modify Button window will appear. 

4. Select your desired Symbol. 

5. Click on the OK button, and then your Macro Icon will change to your selected symbol in 

the Customize Quick Access Toolbar option panel. 

6. Click on the OK button, and then your Macro Icon symbol will appear on the Quick Access 

Toolbar. 
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XV. Practice 
 

The earlier exercises produced a PivotTable and PivotChart that represented the Total sales 

during Terms by each Salesperson. With the added Slicer, you were then able to view desired 

Salesperson’s totals. You were also able to view desired Branch campuses by using the Column 

Labels Filter.  

 

 

 

1. Create a PivotTable using the existing practice worksheet 

(Excel2016_Pivot_Practice.xlsx). 

 

2. Use the PivotTable to answer the question: Which salesperson sold the lowest amount 

during the Fall, Spring, and Summer Term? Hint: First decide which fields you need 

to answer the question. 

 

3. Experiment by placing different fields in the rows and columns sections. 

 

4. Add a Slicer and filter the report with the Slicer. 

 

5. Create a PivotChart. 


